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This guide describes how to install and use MassHunter Mass 
Profiler Software.

What is MassHunter Mass Profiler software?

MassHunter Mass Profiler software operates on the extracted 
data files (.mhd files) produced by MassHunter Qualitative 
Analysis software to let you investigate similarities and 
differences in features across multiple analyses/samples. 
MassHunter Mass Profiler software aligns and normalizes 
features from different .mhd files and allows you to identify 
features using a molecular formula generator and/or a 
database.
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Terminology

Features Features are discrete molecular entities defined by a particular 
retention time and mass.

Samples .mhd files represent individual sample analyses and are called 
samples in MassHunter Mass Profiler software.

Groups Related samples can be grouped together for analysis. An example of 
two groups are “Experiment” and “Control”.

Project A project is one or two sample groups considered together for 
analysis.

Method A method is all the parameters used for filtering, aligning, 
normalizing, and processing samples in MassHunter Mass Profiler software.

Processing

The results of processing samples are presented in the MassHunter Mass 
Profiler software main window Feature Plot and Feature Table.

Feature Plot
allows you to:

• Investigate features using five different plot types: Mass vs. Retention Time, 
Log2 Ratio vs. Retention Time, Log/Log plot, Unique to <Group 1> and 
Unique to <Group 2>.

• Investigate features in individual or multiple samples

• Investigate features that exceed a certain visibility threshold

• Investigate features by average mass and RT across all samples or use color 
to distinguish individual features or to identify features by sample or group.

See “Feature Plot” on page 9 for more information.

Feature Table
allows you to:

• View all the features for their summary, group statistics and differences 
between the two groups.

• View individual feature details, including species clusters found in a 
selected sample.

See “Feature Table” on page 13 for more information.
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Identification

MassHunter Mass Profiler software allows you to identify feature composition 
using a molecular formula generator (MFG) and/or a database. Features can 
be identified individually or in a batch. Batches can be defined by either the 
current contents of the Feature Plot or the Feature Table. You can save 
identification results in files to review later. See “Identifying Features” on 
page 34 for more information.

Exporting data

You can export data generated by MassHunter Mass Profiler software for use 
with other programs as follows:

From Feature
Table

• Summary data from the feature table for use in Excel (.xls format).

• Averaged ion data (m/z and RT of representative ions) for each feature in 
the table (in .csv format), for use in data acquisition in targeted MS/MS 
experiments.

• All data from the feature table for use in GeneSpring MS (.txt format).

From Feature Plot • Summary data from the graphed feature plot for use in Excel (.xls format).

• Averaged ion data (m/z and RT of representative ions) for each feature in 
the graphed feature plot for use in data acquisition in targeted MS/MS 
experiments (.csv format).

• All data from the graphed feature plot for use in GeneSpring MS (.txt 
format).

See “Exporting Mass Profiler Data” on page 37 for more information.

Where to find more information

Use the online help for in-depth information not given in this Quick Start 
Guide. Display online help in either of the following ways:

• Select Contents from the MassHunter Mass Profiler Software Help menu.

• Press the F1 key to get more information about a window, tab, or dialog box.
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Installation

If the MassHunter Mass Profiler Software is not already installed on your 
system, install it as follows.

1 Insert the CD-ROM labeled Agilent G3297AA into the CDROM drive.
2 Click the Windows Start button and select Run.
3 Type x:\setup, where x is the letter of the CDROM drive, and click OK.
4 Follow the instructions on the screen to install the software.

To uninstall the software

Use the Add/Remove window of the Control Panel.

Startup

Double-click the Mass Profiler icon  on the desktop, or select Programs> 
Agilent> MassHunter Workstation> Mass Profiler from the desktop, to start 
the MassHunter Mass Profiler Software.
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Main Window

The MassHunter Mass Profiler Software main window has the following areas 
and controls.

• “Menus” (below)

• “Toolbar” on page 9

• “Feature Plot” on page 9

• “Feature Table” on page 13

Menus

The following menu options are available in MassHunter Mass Profiler 
Software:

File menu

Create New Project Opens the New Project dialog box, which allows you to set 
up a new project for use in MassHunter Mass Profiler Software. See “To create 
a project” on page 18.

Open and Process Project Allows you to open a project. Processing is 
performed automatically using the current method parameters.

Edit Project Opens the Edit Project dialog box, which allows you to edit the 
current project. See “To edit a project” on page 24.

Save Project Allows you to save changes to the current project.

Save Project As Allows you to save the current project under a new name.

Export Feature Summary from Feature Table Allows you to export the feature 
summary information from the feature table for use in Excel (.xls format).

Export Inclusion List from Feature Table Opens the Export Inclusion List 
Options dialog box, which allows you to specify parameters for exporting the 
averaged ion data (m/z and RT of representative ions) for each feature in the 
table (in .csv format), for use in data acquisition in targeted MS/MS 
experiments.
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Export GeneSpring Input File from Feature Table Allows you to export the 
feature table for use in GeneSpring MS (.txt format).

Export Feature Summary from Graphed Data Allows you to export the graphed 
feature plot for use in Excel (.xls format).

Export Inclusion List from Graphed Data Opens the Export Inclusion List 
Options dialog box, which allows you to specify parameters for exporting the 
averaged ion data (m/z and RT of representative ions) for each feature in the 
plot (in .csv format), for use in data acquisition in targeted MS/MS 
experiments.

Export GeneSpring Input File from Graphed Data Allows you to export the 
graphed feature plot for use in GeneSpring MS (.txt format).

Exit Closes the MassHunter Mass Profiler Software window and exits the 
program. 

Method menu

Methods parameters define and restrict the features that appear in the plot 
and table. 

Open and Apply Method Allows you to open a method and automatically 
process the current project with the parameters in the method you open. See 
“To apply a different method” on page 24.

Edit Method Opens the Method Parameters dialog box, which allows you to 
edit the current method. Method parameters appear on three tabs: 
Pre-Analysis Filters, Alignment & Normalization, and Result Filters. See “To 
edit a method” on page 19.

Save Method Allows you to save changes to the current method.

Save Method As Allows you to save the current method parameters as a new 
method.

Reset Method to Default Restores all method parameters to their default 
values.
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View menu

Show Corrected Times/Show Raw Times If an RT correction is performed as 
part of the method, then a "corrected time" is calculated for each feature and 
each sample. Selecting Show Corrected Times displays the values of these 
corrected retention times. Selecting Show Raw Times displays the raw 
(original) retention times from the *.mhd files (without correction).

Feature Details for Selected Feature Opens the Feature Information window 
for the feature selected in the Feature Table. See “To view feature details” on 
page 28.

Abundance Distribution for Selected Feature Opens the Single Abundance 
Feature Distribution window, which displays plots that show the distribution 
of abundance for the samples in the two groups. The abundance distribution of 
each sample for the feature is presented as a histogram and as curves that are 
color-coded for the group. The curves are calculated by using the least-squared 
fit to a Gaussian shape. See “To view the abundance distribution graph for a 
feature” on page 31.

Global Occurrence Histograms Opens the Global Occurrence Histograms 
window, which displays histograms that show how frequently a feature occurs 
in samples within each group and across both groups. See “To view global 
occurrence histograms” on page 32.

Web menu

Performs a mass search for the feature currently selected in the plot or table 
and displays the results in your internet browser window. You can search the 
following databases:

• ChemIDplus

• HMP

• NIST

• PubChem

• Web METLIN



8 Agilent Mass Profiler Software Quick Start Guide

Image menu

Print Image Allows you to print the current Feature Plot image.

Copy Image to Clipboard Allows you to copy the current Feature Plot image to 
the Clipboard to paste into other applications as either a Metafile or Bitmap.

Save Image to File Allows you to save the current Feature Plot image as either 
a Metafile (.emf format) or Bitmap (.bmp format).

Identify menu

Change Parameters Opens the Feature Identification Parameters dialog box, 
which allows you to set parameters used to identify the feature when you 
perform a Composition Search or a Batch Search.

Open Search Result Allows you to view previous batch search results that 
were saved in feature composition files (.fcf format).

Batch Search for Feature Table Performs a batch search for the features 
displayed in the Feature Table, using parameters set on the Feature 
Identification Parameters dialog box. The results are displayed in the Feature 
Identification Results window.

Batch Search for Graphed Data Performs a batch search for the features 
displayed in the selected tab of the Feature Plot, using parameters set on the 
Feature Identification Parameters dialog box. The results are displayed in the 
Feature Identification Results window.

Composition Search for Selected Feature Performs a composition search for 
the feature currently selected in the Feature Table or Feature Plot, using the 
parameters set on the Feature Identification Parameters dialog box. The 
results are displayed in the Composition Search Results window.

Help menu

Contents Opens the online help window for MassHunter Mass Profiler 
software with the Contents tab displayed.

About Displays version information for MassHunter Mass Profiler software.
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Toolbar

The following items are available on the MassHunter Mass Profiler Software 
toolbar:

Feature Plot

This area of the MassHunter Mass Profiler Software window shows the results 
of processing a project with the current method and allows you to see 
differences between features in two groups of samples. It displays processed 
data automatically when you create a new project, open and process a project, 
edit a project, open and apply a method, or edit a method.

You can change the plot style and limit the data that appears in the Feature 
Plot using the options described below. See “To view results in the Feature 
Plot” on page 25.

Graph data

Allows you to select between displaying all samples or a single sample. This is 
set initially to display All samples.

Button Equivalent menu item

File > Create New Project

File > Open and Process Project

File > Save Project

Method > Open and Apply Method

Method > Edit Method

Method > Save Method

Identify > Batch Search for Feature Table
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Plot style

Allows you to select the style of plot to display from the following:

Average Feature Uses the group averages as the feature properties (Mass, RT, 
and Abundance).

Colored by feature Plots each distinct feature in a different color. In practice, 
however, since there may be a large number of features, only distinct features 
near each other are different colors.

Colored by sample Plots the features in the same sample in the same color 
(e.g., if there are 10 samples, then there are 10 colors).

Colored by group Two colors, blue and red, represent the features in the two 
groups of samples.

Visibility criterion

Allows you to select one of the following criteria, whose threshold determines 
which features will be highlighted (i.e. appear as solid dots) in the plot. 
Features that don’t meet the threshold value are plotted as dimmed open 
circles.

Max RSD abundance The max of relative standard deviations of the two 
groups, that is, any feature whose max group abundance-RSD is larger than 
the threshold is filtered out (plotted as an open circle).

SD RT Standard deviation for the retention time

SD Mass Standard deviation for the mass

Differential Score Relative score from 0 to 100 that indicates if the difference 
in abundance of a feature in the two groups is significant. Two methods are 
available for calculating the differential score, Student t-test or SVM 
sensitivity, set on the Result Filters tab of the Method Parameters dialog box 
as described in “To perform a differential analysis and set result filters” on 
page 23.

None (the default) No visibility criterion is applied, so all features are 
highlighted.



Agilent Mass Profiler Software Quick Start Guide 11

Visibility threshold

Sets the threshold for the selected Visibility Criterion. Features that don’t 
meet the threshold for the selected Visibility Criterion appear as dimmed open 
circles in the plot.

Feature Plot tabs

The tabs at the top of the Feature Plot allow you to view the following different 
plot types:

Mass vs. RT Plots mass vs. retention time (RT) for each feature.

Log2 Ratio vs. RT Plots the log2 of the ratio of abundance vs. retention time.

• For Average feature plot style, the abundance ratio is average abundance 
for <Group 1> over the average abundance for <Group 2>. 

• For Colored by plot styles, the abundance ratio is the abundance for a 
single feature over the average abundance of that feature in its group. 

Log/Log Plot Plots the log2 of the average abundance of a feature: 

• in <Group 1> vs. log2 of its average abundance in <Group 2> for Average 
feature plot style

• in a single sample vs. the log2 of the average of its group for the Colored by 
plot styles

Unique to <Group 1> Plots only those features that are present in the first 
group of samples, but not in the second group of samples.

Unique to <Group 2> Plots only those features that are present in the second 
group of samples, but not in the first group of samples.

Expression

Allows you to show only the features that have a larger average abundance in 
one group as follows:

Up Shows only features that have a larger average abundance in <Group 1> 
than in <Group 2> (called up-regulated). These are the features whose values 
appear in red in the Log2(A1/A2) and |Log2(A1/A2)| columns of the Feature 
Table.
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Down Shows only features that have a larger average abundance in <Group 
2> than in <Group 1> (called down-regulated). These are the features whose 
values appear in blue in the Log2(A1/A2) and |Log2(A1/A2)| columns of the 
Feature Table.

Plot mouse actions

• Zoom—Drag the mouse to define an area of interest. The area expands when 
you release the mouse button.

• Pass the cursor over a feature to view information about that feature.

• Click in the plot to select the feature that is closest to that location and to 
highlight the row in the Feature Table that corresponds to that feature.

Plot shortcut menu

The following options appear when you right-click anywhere on a plot. Note 
that right-clicking in the plot also changes the selection in the table to the 
nearest data point.

Unzoom Returns the plot to the previous zoom level.

Autoscale Returns the plot to the original display.

Print Image Allows you to send the image to a printer.

Copy Image to Clipboard Allows you to copy the current image to the 
Clipboard to paste into other applications as either a Metafile or Bitmap.

Save Image to File Allows you to save the current image as either a Metafile 
(.emf format) or Bitmap (.bmp format).

Feature Details Opens the Feature Information window for the feature that is 
closest to that location on the plot.

Abundance Distribution Opens the Single Feature Abundance Distribution 
window, which displays the plots that show the distribution of abundance for 
the samples in the two groups.
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Composition Search Performs a composition search for the selected feature, 
using the parameters set on the Feature Identification Parameters dialog box. 
The results are displayed in the Composition Search Results window.

Web Performs a mass search for the feature currently selected in the plot 
and displays the results in your internet browser window. You can search the 
following databases: ChemIDplus, HMP, NIST, PubChem, and Web METLIN.

Feature Table

This area of the MassHunter Mass Profiler Software window shows the results 
of processing a project with the current method. It displays processed data 
automatically when you create a new project, open and process a project, edit 
a project, open and apply a method, or edit a method. It allows you to see the 
primary feature values, including the average values for each feature across 
both groups and then each group separately. The table can be sorted by the 
values in any column by clicking on the column heading of interest.

Color coding in
table

Red Up-regulated features, which are features that have a larger average 
abundance in <Group 1> than in <Group 2>.

Blue Down-regulated features, which are features that have a larger average 
abundance in <Group 2> than in <Group 1>.

Green Internal standards, if used.

Expression

Allows you to show only the features that have a larger average abundance in 
one group as follows:

Up Filters the table to show only up-regulated features (red).

Down Filters the table to show only down-regulated features (blue).

Both Shows all features in the table.

Feature summary

These values are averages for the feature across all samples.
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ID (row number) Feature identification number, assigned based on the values 
in the Abundance column. The table is initially sorted by these values, but the 
sort order can be changed by clicking on the heading of any other column.

RT Average retention time of the feature in all samples

SD Standard deviation of the retention time of the feature in all samples

Mass Average mass of the feature in all samples

SD Standard deviation of the average mass of the feature in all samples

Abundance Average abundance of the feature across the samples in both 
groups

RSD Relative standard deviation of the abundance of the feature across the 
samples in both groups

Freq The number of samples in both groups that contain this feature

Mark This column can be used to mark a feature of special interest. This 
annotation is exported along with the other data in the table, so that the 
feature can still be distinguished when viewed in other programs. 

To place or clear an X in the Mark cell, right-click on the row number cell on 
the left side of the Feature Table for the feature of interest, and select the 
Mark On/Off item in the shortcut menu.

<Group 1>, <Group 2>

The values in these parts of the table are averages for the feature across the 
samples within the individual groups only.

RT Average retention time of the feature within the group

Mass Average mass of the feature within the group

Abundance Abundance of the feature within the group

RSD Relative standard deviation of the abundance of the feature in the group
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Freq The number of samples in the group that contain this feature

Comparison

The values in this part of the table are average differences for the feature 
between samples in both groups.

RT The difference in the retention time of the feature between the groups

Mass The difference in the mass of the feature between the groups

log2(A1/A2) The log of the ratio of the average feature abundance for all 
samples in <Group 1> over the feature abundance for all samples in <Group 2>. 
Values in this column are color-coded as follows:

• Red values mean that the average abundance for the feature is greater in 
<Group 1> than in <Group 2> (called up-regulated). 

• Blue values indicate that the average abundance for the feature is less in 
<Group 1> than in <Group 2> (called down-regulated).

• Green values are internal standards, if used.

|log2(A1/A2)| The absolute value of the above expression.

Diff. Score The differential score, which is a number between 0 and 100 that 
represents the relative confidence that the difference in intensity of a feature 
between the two groups is real. Two methods are available for calculating the 
differential score, Student t-test or SVM sensitivity, set on the Result Filters 
tab of the Method Parameters dialog box as described in “To perform a 
differential analysis and set result filters” on page 23.

Feature Table shortcut menu

The following options appear when you right-click in any row number cell on 
the left side of the Feature Table:

Feature Details Displays the Feature Information window for that feature.

Abundance Distribution Opens the Single Feature Abundance Distribution 
window, which displays the plots that show the distribution of abundance for 
the feature in the samples in the two groups. 
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Composition Search Performs a composition search for the feature selected in 
the Feature Table, using the parameters set on the Feature Identification 
Parameters dialog box. The results are displayed in the Composition Search 
Results window.

Web Performs a mass search for the feature currently selected in the table 
and displays the results in your internet browser window. You can search the 
following databases: ChemIDplus, HMP, NIST, PubChem, and Web METLIN.

Mark On/Off Marks or clears the selected feature so that you can identify it 
for later use. The mark (X) appears or is cleared in the Mark column of the 
Feature summary area on the left side of the table. This mark is retained 
when you export data as described in “To export data from the Feature Table”.
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Getting Started

The following topics will help you get started with Agilent MassHunter Mass 
Profiler Software. This guide and the online help explain these activities.

Processing Data
• “To create a project” on page 18
• “To edit a method” on page 19
• “To filter features” on page 20
• “To align features” on page 21
• “To normalize features” on page 22
• “To perform a differential analysis and set result filters” on page 23
• “To apply a different method” on page 24
• “To edit a project” on page 24

Viewing Results
• “To view results in the Feature Plot” on page 25 
• “To set Feature Plot filters and colors” on page 26
• “To select Feature Plot view” on page 27
• “To view results in the Feature Table” on page 28
• “To view feature details” on page 28
• “To print, save, or copy the Feature Plot image” on page 29
• “To view more information” on page 30
• “To view the abundance distribution graph for a feature” on page 31
• “To view global occurrence histograms” on page 32

Identifying Features
• “To set feature identification parameters” on page 34 
• “To identify a single feature” on page 35
• “To identify a batch of features” on page 35
• “To view batch search results later” on page 36

Exporting Mass Profiler Data

• “To mark features for annotation” on page 37 
• “To export data from the Feature Table” on page 37 
• “To export data from the Feature Plot” on page 38
• “To export feature summary data from a Batch Search” on page 39
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Processing Data

To process data in MassHunter Mass Profiler Software, samples (.mhd output 
files from MassHunter Qualitative Analysis software) are first organized into 
groups in a project. Processing parameters are set in methods and the current 
method is automatically applied to the current project (samples). You can edit 
the method and set various filters for the data you want to consider. 

To create a project

Use this procedure to set up a project that contains the samples (.mhd files) 
that you want to investigate.
1 Select Create New Project from the File menu, or click the Create New 

Project button on the toolbar.
2 On the New Project dialog box:

a Type in a name for the project.

b Specify whether you want 1 or 2 groups in the project.
3 Set up the first group of samples on the left side of the screen as follows:

a Type in a name for the group, or accept the default name “Experiment”.

b Click the Samples Add button to open the Select Files dialog box.

c Select the .mhd files to add to the group. Use Ctrl+click to select multiple 
files.

d Click the Open button on the Select Files dialog box. The files you 
selected are listed for the first group on the New Project dialog box.

e (Optional) Enter a value in the Scalar column for a sample to multiply 
feature abundance values by a set amount in that sample.

4 If you selected 2 groups for the project in Step 2, set up the second group of 
samples on the right side of the screen as follows:

a Type in a name for the group, or accept the default name “Control”.

b Click the Samples Add button to open the Select Files dialog box.

c Select the .mhd files to add to the group. Use Ctrl+click to select multiple 
files.

d Click the Open button on the Select Files dialog box. The files you 
selected are listed for the second group on the New Project dialog box.

e (Optional) Enter a value in the Scalar column for a sample to multiply 
feature abundance values by a set amount in that sample.
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5 Click OK on the New Project dialog box. The samples are automatically 
processed using the current method and the results are displayed in the 
Feature Plot and Feature Table in the Mass Profiler main window.

6 To obtain different results, apply a different method to the project as 
described on page 24, or change parameters in the current method as 
described in “To edit a method” below.

7 (Optional) To save the changes to the current project, select Save Project 
from the File menu or click the Save Project button on the toolbar.

8 (Optional) To save the project under a new name for later use, select Save 
Project As from the File menu, enter a name for the project (.mpp file), and 
click the Save button on the Save As dialog box.

Projects can be modified later as described in “To edit a project” on page 24.

To edit a method

Use this procedure to edit method parameters for processing the samples in 
your project. You can save methods for later use.
1 Select Edit Method from the Method menu, or click the Edit Method 

button on the toolbar.
2 Set parameters on the following tabs of the Method Parameters dialog box:

• Pre-Analysis Filters, see “To filter features” below.

• Alignment & Normalization, see “To align features” on page 21 and “To 
normalize features” on page 22

• Result Filters, see “To perform a differential analysis and set result 
filters” on page 23

3 Click OK. The samples in the current project are automatically processed 
using the current method and the results are displayed in the Feature Plot 
and Feature Table in the Mass Profiler main window.

4 (Optional) To save the changes to the current method, select Save Method 
from the Method menu or click the Save Method button on the toolbar.

5 (Optional) To save the method under a new name for later use, select Save 
Method As from the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To filter features 

Use the following procedure to set limits on the raw features that are loaded 
into MassHunter Mass Profiler Software from the incoming .mhd files, which 
contain all the extracted features from Mass Hunter Qualitative Analysis 
software.

1 Select Edit Method from the Method menu, or click the Edit Method 
button on the toolbar to open the Method Parameters dialog box.

2 Set filter parameters on the Pre-Analysis Filters tab:

• Feature Position — To filter based on retention time and or mass

• Isotope Pattern — To filter based on isotope distribution pattern

• Charge State — To filter by charge state

• Abundance — To specify feature abundance parameters

• Special Masses — To exclude or limit features with certain masses

• Mass Defect (Da) — To set a range for the acceptable mass defect

• Features of unknown mass — To include or exclude certain special 
features

• Number of ions — A large number of ions detected for a feature usually 
indicates robustness of the feature detection. Specifying a minimum 
Number of ions will filter out features that may be less reliable.

• Neutral losses — Allows you to specify that only some special features be 
considered in the analysis. For example, to only consider features that 
are subject to a water loss in the mass spectrometer, type 18.01 (the 
weight of H2O) in the Neutral losses text box. In this case, MassHunter 
Mass Profiler Software will search feature pairs that have the same RT 
and with their masses 18.01 Da apart (+ a specified Tolerance value) and 
only these feature pairs are used for the analysis.

3 Click OK to initiate the analysis, using the values entered in Step 2 above, 
along with current values from the Alignment & Normalization tab and the 
Result Filters tab.

4 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 25.

5 (Optional) To save the changes to the current method, select Save Method 
from the Method menu or click the Save Method button on the toolbar.

6 (Optional) To save the method under a new name for later use, select Save 
Method As from the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To align features 

Use the following procedure to set parameters to adjust for retention time 
shifts in the raw data and correlate compounds across samples based on mass 
and  retention time.

1 Select Edit Method from the Method menu, or click the Edit Method 
button on the toolbar to open the Method Parameters dialog box.

2 Set the following Alignment parameters on the Alignment & 
Normalization tab.

• Mass tolerance (Intercept and Slope)

• RT tolerance Before RT correction (Intercept and Slope)

• RT correction method (Without standards, With standards, or None)

• RT tolerance After RT correction (Intercept and Slope)
3 If you selected With standards for the RT correction method in Step 2, set 

the following additional options on the left side of the screen:

• No. of Internal Standards (at least two need to be defined)

• The RT and Mass for each internal standard

• Mark the Algn (alignment) check box to enable retention time 
correction.

• Clear the Norm (normalization) check box, unless you plan to use 
internal standards for normalization as described in “To normalize 
features” below.

4 Click OK to initiate the analysis, using the values entered in Steps 2 and 3 
above, along with current values from the Pre-Analysis Filters tab and the 
Result Filters tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 25.

6 (Optional) To save the changes to the current method, select Save Method 
from the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, select Save 
Method As from the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To normalize features 

1 Select Edit Method from the Method menu, or click the Edit Method 
button on the toolbar to open the Method Parameters dialog box.

2 Select one of the Normalization options (Without standards or With 
standards) on the right side of the Alignment & Normalization tab.

3 If you selected With standards in Step 2, set the following additional 
options on the left side of the screen:

• No. of Internal Standards (at least two need to be defined)

• The RT and Mass for each internal standard

• Mark the Norm (normalization) check box.

• Clear the Algn (alignment) check box, unless you plan to use internal 
standards for alignment as described in “To align features” on page 21.

4 Click OK to initiate the analysis, using the values entered in Steps 2 and 3 
above, along with current values from the Pre-Analysis Filters tab and the 
Result Filters tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 25.

6 (Optional) To save the changes to the current method, select Save Method 
from the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, select Save 
Method As from the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To perform a differential analysis and set result filters

1 Select Edit Method from the Method menu, or click the Edit Method 
button on the toolbar to open the Method Parameters dialog box.

2 Set the following Analysis preferences on the Result Filters tab:

• Missing-info treatment—0 abundance or excluded. Note that you can’t 
select Excluded if you select SVM sensitivity as the Differential scoring 
method.

• Differential scoring—one of the following:

Student t-test–assesses if the abundance distribution for a given feature 
is statistically different between the two groups

SVM sensitivity–measures the degree to which the abundance of a given 
feature contributes to the location and separating power of a hyperplane 
identified in multidimensional feature-abundance space that maximally 
separates the features in two groups (SVM=Support Vector Machine)

3 Set the following Result filters:

• Min |log2 (abund1/abund2)|

• Min differential score

• Expression—Both, Up (up-regulated), or Down (down-regulated)

• Min relative frequency and one of the following options: And unique to 
a single group, in at least one group, in all groups, or of total

• Saturated features—Allows you to exclude features that were marked as 
saturated by MassHunter Qualitative Analysis software.

• Max number of features—Unlimited or Most abundant <n> features
4 Click OK to perform the analysis, using the values entered in Steps 2 and 3 

above, along with current values from the Pre-Analysis Filters tab and the 
Alignment & Normalization tab.

5 View the results in the Feature Plot and Feature Table, as described in 
“Viewing Results” on page 25.

6 (Optional) To save the changes to the current method, select Save Method 
from the Method menu or click the Save Method button on the toolbar.

7 (Optional) To save the method under a new name for later use, select Save 
Method As from the Method menu, enter a name for the method (.mpm file), 
and click the Save button on the Save As dialog box.
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To apply a different method

1 Select Open and Apply Method from the Method menu, or click the Open 
and Apply Method button on the toolbar.

2 Select a method in the Open dialog box and click the Open button.
3 The parameters in the selected method are applied to the current project 

and the results are displayed in the Feature Plot and Feature Table.

To edit a project

Use this procedure to change the properties of an existing project, such as 
name, group names, sample composition, and sample scalar values.

1 Select Edit Project from the File menu to open the Edit Project dialog box.
2 Make the desired changes to the project, such as:

• Add samples using the Add button

• Delete samples using the Delete button

• Change project name

• Change group names

• Change scalar values for samples

Note that you can’t change the number of groups when you edit a project.
3 Click OK on the Edit Project dialog box. The samples are automatically 

processed using the current method and the results are displayed in the 
Feature Plot and Feature Table in the Mass Profiler main window.

4 (Optional) To save the changes to the current project, select Save Project 
from the File menu or click the Save Project button on the toolbar.

5 (Optional) To save the project under a new name for later use, select Save 
Project As from the File menu, enter a name for the project (.mpp file), and 
click the Save button on the Save As dialog box.
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Viewing Results

Results are shown automatically in the Feature Plot and Feature Table areas of 
the MassHunter Mass Profiler Software window when a project is processed 
with the current method parameters. Processing is performed automatically 
after the following activities:

• Creating or editing a project

• Opening and processing a project

• Applying a different method

• Editing a method

See Also “To view results in the Feature Plot” below
“To set Feature Plot filters and colors” on page 26
“To select Feature Plot view” on page 27
“To view results in the Feature Table” on page 28
“To view feature details” on page 28

To view results in the Feature Plot

A plot of Mass vs Retention Time for each feature, averaged across all the 
samples, is automatically displayed in the Feature Plot (Mass vs. RT tab). 

1 Pass the cursor over a data point (feature) of interest on the plot to display 
a brief description of that feature.

2 Zoom in by dragging the mouse around the area of interest. The area is 
expanded when you release the mouse button.

3 You can change how features are displayed in the Feature Plot as described 
in “To set Feature Plot filters and colors” on page 26.

4 Click on a different tab above the graph to view a different plot, as 
described in “To select Feature Plot view” on page 27.

5 Click on a data point in the plot to highlight the corresponding row for that 
feature in the Feature Table. See “To view results in the Feature Table” on 
page 28.

6 Right-click in the plot to access the shortcut menu options described on 
page 12.

See Also “To view feature details” on page 28
“To print, save, or copy the Feature Plot image” on page 29
“To export data from the Feature Plot” on page 38
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To set Feature Plot filters and colors

Use the following procedure to limit the features that are shown in the plot 
and to use color to identify features individually, by sample, or by group. These 
steps are all optional and can be selected in any order.

The plot settings are as follows when the results are first displayed after 
processing:

• Graph data = All samples (.mhd files)

• Plot style = Average feature (shows data points in black, representing 
the average mass and RT of features across all samples)

• Visibility criterion = None (highlights all features)

• Expression = Both (shows both up- and down-regulated features)

1 To see the feature data from a single sample only, select the .mhd file of 
interest from the Graph data list.

2 Set the Plot style to one of the following settings to change color the data 
points to distinguish features in various ways:

• Colored by feature—To distinguish each feature with a different color. 
The data points for the same feature in each sample appear (no longer 
averaged across all .mhd files). For example, if a feature is present in all 
ten samples, the black data point for an average feature becomes ten 
green data points (because of slightly different RTs). The system has a 
limit of 10 colors, so the same color will be used for multiple features if 
you have more than 10 features.

• Colored by sample—To distinguish features in the same sample (.mhd 
file). All features in the same sample appear in the same color. So if there 
are ten samples, then data points appear in ten colors. The system has a 
limit of 10 colors, so the same color will be used for multiple samples if 
you have more than 10 samples.

• Colored by group—To distinguish features in a group. (Red for features 
in <Group 1>, Blue for features in <Group 2>).

3 To filter features using a visibility criterion and threshold:

a Select one of the following from the Visibility criterion list: Max RSD 
abundance, SD RT, SD Mass, or Differential Score.

b Adjust the Visibility threshold to the desired level.
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4 To show only features that have a larger average abundance in one group:

a Select Up for Expression (below the Feature Plot) to plot only features 
that have a larger average abundance in <Group 1> than in <Group 2> 
(called up-regulated).

b Select Down for Expression (below the Feature Plot) to plot only 
features that have a larger average abundance in <Group 2> than in 
<Group 1> (called down-regulated).

To select Feature Plot view

Use this procedure to select a different plot view for the results of analysis in 
the Feature Plot. The Mass vs. RT plot is presented by default when samples 
are analyzed.

1 Click the Log2 Ratio vs RT tab to view a plot of the log2(A1/A2) value for a 
feature versus the retention time. For Average feature plot style, A1 is the 
abundance of <Group 1> and A2 is the abundance of <Group 2>.  For the 
Colored by plot styles, A1 is the abundance of a single feature and A2 is the 
average abundance of that feature in its group.

2 Click the Log/Log Plot tab to view a plot of the log2 of the average 
abundance of a feature:

• in <Group 1> vs log2 of its average abundance in <Group 2> for Average 
feature plot style

• in a single sample vs the log2 of the average of its group for the Colored 
by plot styles

3 Click the Unique to <Group 1> tab to view a plot of only those features that 
are present in the first group of samples, but not in the second group of 
samples.

4 Click the Unique to <Group 2> tab to view a plot of only those features that 
are present in the second group of samples, but not in the first group of 
samples.

5 Click the Mass vs. RT tab to view the original plot, i.e. mass vs. retention 
time (RT) for each feature.
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To view results in the Feature Table

The Feature Table contains average values and standard deviations for each 
feature across all samples (Feature summary) and each group separately, 
including retention time (RT), Mass, Abundance, Freq (frequency), SD 
(standard deviation) for RT and Mass, and RSD (relative standard deviation) 
for Abundance values.

1 Scroll horizontally to view Comparison data on the right of the table.
2 Notice the color of values for the features in the Log2(A1/A2) and 

|Log2(A1/A2)| columns:

• Red values mean that the average abundance of the feature is greater in 
<Group 1> than in <Group 2> (called up-regulated). 

• Blue values indicate that the average abundance of the feature is greater 
in <Group 2> than in <Group 1> (called down-regulated).

• Green values are internal standards, if used.
3 To show only the features that have a larger average abundance in one 

group:

a Select Up for Expression (above the Feature Table) to show only 
up-regulated features. Note that all of the values in the Log2(A1/A2) and 
|Log2(A1/A2)|columns of the Feature Table are displayed in red.

b Select Down for Expression (above the Feature Table) to show only 
down-regulated features. Note that all of the values in the Log2(A1/A2) 
and |Log2(A1/A2)|columns of the Feature Table are displayed in blue.

4 By default, the table is ordered from the highest average Abundance value 
to the lowest. Click on a different column heading to sort the table by the 
values in that column, such as Mass or RT.

5 Right-click in any row number cell on the left side of the Feature Table to 
access the shortcut menu options described on page 15.

See Also “To view feature details” below
“To export data from the Feature Table” on page 37

To view feature details

Use this procedure to view more information about a selected feature.

1 Open the Feature Information window for a selected feature in any of the 
following ways:
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From the Feature
Table

• Click to select the feature of interest in the Feature Table, then select 
Feature Details for Selected Feature from the View menu, or 

• Right-click the row number for the feature in the Feature Table, and 
select Feature Details from the shortcut menu.

From the Feature
Plot

• Right-click on the feature of interest in the Feature Plot, and select 
Feature Details from the shortcut menu. 

2 Review the information for the feature in all the .mhd files (samples) in the 
All mhd files table in the top left area of the screen, such as File ID number, 
File name, RT, Mass, and Abundance. Samples in <Group 1> appear in red; 
samples in <Group 2> appear in blue. Click on a column heading to sort the 
table by the values in that column, such as Abundance or Mass. Note the 
selected feature may not be present in every sample in the project.

3 Click to select a row (sample) in the All mhd files table and view the 
information for the feature in the selected sample, such as Species, RT, 
m/z, Mass, Abundance, and Width that is displayed in the table below the 
All mhd files table.

4 On the right side of the screen, view the species cluster plots for all samples 
that the feature is in. Zoom in by dragging the mouse around the area of 
interest. The area is expanded when you release the mouse button. 

5 Right-click on a species cluster plot to access the following options:

• Unzoom– Returns the plot to the previous zoom level.

• Autoscale– Returns the plot to the original display.

• Print Image– Allows you to send the image to a printer.

• Copy Image to Clipboard– Allows you to copy the current image to the 
Clipboard to paste into other applications as either a Metafile or Bitmap.

• Save Image to File– Allows you to save the current image as either a 
Metafile (.emf format) or Bitmap (.bmp format).

To print, save, or copy the Feature Plot image

1 Select the appropriate item from the Image menu:

• Print Image

• Copy Image to Clipboard

• Save Image to File
2 If you selected either Copy Image to Clipboard or Save Image to File, 

select the file format (either Metafile or Bitmap).

Alternate method These same menu options are available by right-clicking in the Feature Plot.



30 Agilent Mass Profiler Software Quick Start Guide

To view more information 

Use this procedure to access more information about selected features in any 
of the following online databases: ChemIDplus, HMP, NIST, PubChem, or Web 
METLIN.

From the
Feature Table

Method 1:

1 Click to select the feature of interest in the Feature Table.
2 Select which database to search from the Web menu.

Method 2:

1 Right-click on the row number for the feature of interest in the Feature 
Table to display the shortcut menu.

2 Select which database to search from the Web submenu.

From the
Feature Plot

Method 1:

1 Click to select the feature of interest in the Feature Plot. (Note that the 
selected feature is highlighted in the Feature Table.)

2 Select which database to search from the Web menu.

Method 2:

1 Right-click on or near the feature of interest in the Feature Plot to display 
the shortcut menu.

2 Select which database to search from the Web submenu.

In each case above, a mass search is performed for the selected feature in the 
selected database and the results are displayed in your internet browser 
window.
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To view the abundance distribution graph for a feature

1 Open the Abundance Distribution window for a selected feature in any of 
the following ways:

From the
Feature Table

• Click to select the feature of interest in the Feature Table, then select 
Abundance Distribution for Selected Feature from the View menu, or 

• Right-click the row number for the feature in the Feature Table, and 
select Abundance Distribution from the shortcut menu.

From the
Feature Plot

• Right-click on the feature of interest in the Feature Plot, and select 
Abundance Distribution from the shortcut menu. 

2 Review the data presented in the Abundance Distribution window, which is 
presented as both a histogram and as curves color-coded by group (red for 
<Group 1> and blue for <Group 2>), as shown in the following example.

The lower plot is a histogram, with Abundance values on the x-axis. The 
height of the bars are determined by the number of samples whose 
abundance falls into that abundance bin. 

The upper plot has the same x-axis. The distribution curves are calculated 
using the least-squared fit to a Gaussian shape of the bars in the lower plot.
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To view global occurrence histograms

Use this procedure to view global occurrence histograms, which show the 
relationship between the number of features and the number of samples.

1 Select Global Occurrence Histograms from the View menu.
2 Review the information presented in the Global Occurrence Histograms 

window, which displays a histogram for each group and a combined 
histogram of both groups. Each histogram shows the frequency of feature 
occurrence in the samples within a group or within both groups. The x-axis 
is the number of samples that a particular feature occurs in (i. e. 0, 1, 2, 3, 4, 
up to the number of samples in the group). The y-axis is the number of 
features that occur in that number of samples (i.e. from 0 up to the number 
of features in the project). 

Example Global Occurrence Histograms window: 

The center histogram (Control 1 group) in the example above shows that:

• ~20 features do not occur in any sample in this group.
• ~10 features occur in 1 sample in this group.
• ~22 features occur in 2 samples in this group.
• ~25 features occur in 3 samples in this group.
•   50 features occur in 4 samples in this group.
• ~270 features occur in all 5 samples in this group.



Agilent Mass Profiler Software Quick Start Guide 33

The histogram on the right (Combined group) shows that:

• Every feature occurs in at least 5 samples in the project.
• ~21 features occur in 5 of 15 samples in the project.
• ~9 features occur in 6 of 15 samples in the project.
• ~6 features occur in 7 of 15 samples in the project.
• ~7 features occur in 8 of 15 samples in the project.
• ~10 features occur in 9 of 15 samples in the project.
• ~26 features occur in 10 of 15 samples in the project.
• ~17 features occur in 11 of 15 samples in the project.
• ~33 features occur in 12 of 15 samples in the project.
• ~33 features occur in 13 of 15 samples in the project.
• ~68 features occur in 14 of 15 samples in the project.
• ~152 features occur in all 15 samples in the project.
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Identifying Features

The following activities allow you to identify features using either a Molecular 
Formula Generator (MFG) program or a database or both.

• “To set feature identification parameters” below

• “To identify a single feature” on page 35

• “To identify a batch of features” on page 35

• “To view batch search results later” on page 36

To set feature identification parameters

Use this procedure to set parameters that will be used for identifying the 
composition of individual features and batches of features.

1 Select Change Parameters from the Identify menu to open the Feature 
Identification Parameters dialog box.

2 Select the method to use to identify the composition of the feature from the 
following choices:

• MFG only– Use the Molecular Formula Generator only.

• DB only– Use the specified database only. 

• Combined– Use both the Molecular Formula Generator and the specified 
database. 

3 Set the Expected data variation parameters on the left side of the screen.
4 If you selected either MFG only or Combined for the Method in Step 2, set 

the parameters in the Molecular Formula Generator area on the right side 
of the screen.

5 If you selected either DB only or Combined for the Method in Step 2, select 
the Database File name and the RT matching method on the left side of the 
screen.

6 Click OK to close the Feature Identification Parameters dialog box.
7 Initiate a search with the parameters you just set as described in “To 

identify a single feature” on page 35 or “To identify a batch of features” on 
page 35.

NOTE For information on individual feature identification parameters, see the Feature 
Identification Parameters Dialog Box topic in online help.
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To identify a single feature

1 Set feature identification parameters as described on page 34.
2 Select the feature of interest and initiate the composition search in any of 

the following ways:

• Click to select a row (feature) in the Feature Table, then select 
Composition Search for Selected Feature from the Identify menu.

• Right-click the row number for the feature of interest in the Feature 
Table, then select Composition Search from the shortcut menu.

• Right-click on or near the feature of interest on the Feature Plot, then 
select Composition Search from the shortcut menu. 

3 Review the identification search results in the table on the Composition 
Search Results window. The results are color-coded as follows:

• Green– suggested by MFG and hit in DB search

• Red– hit in DB search but not suggested by MFG

• Orange– suggested by MFG but not hit in DB search
4 Click on a hit to view its structure information at the top of the screen, if 

the database you searched contains structure information for the hit 
selected in the results table.

5 Click the Close button to close the Composition Search Results window.

To identify a batch of features

1 Set feature identification parameters as described on page 34.
2 Select the features and initiate the search in any of the following ways:

• To identify the features currently displayed in the Feature Table, select 
Batch Search for Feature Table from the Identify menu or click the 
Batch Search for Feature Table button on the toolbar.

• To identify the features currently displayed in the Feature Plot, select 
Batch Search for Graphed Data from the Identify menu.

3 Review the search results on the Batch Result tab of the Feature 
Identification Results window.

a The features to identify are listed in the table at the top. Clicking on a 
row (feature) in the table displays the hits found for that feature in the 
results table in the lower part of the window. 

b Features shown in red in the upper table are those whose Best candidate 
conflicts with the Best candidate for another feature. Note that two 
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features are not considered conflicting if their Best candidates have the 
same formula but are associated with different database entries.

c Hits in the lower table are color-coded as follows:

• Green– suggested by MFG and hit in DB search

• Red– hit in DB search but not suggested by MFG

• Orange– suggested by MFG but not hit in DB search

d The check mark in the Best column of the lower table indicates the hit 
that has been determined to be the best fit for the feature, based on fit to 
mass (MFG and DB), RT (DB only, if used), and isotope distribution 
(MFG only). To manually select a different hit as the best fit, click in the 
Best column for the desired row (hit) in the results table or clear the 
check mark to not select a best hit for that feature.

e You can also view structure information on the right side of the screen, if 
the database you searched contains structure information for the hit 
selected in the results table.

4 Click on the Batch Summary tab of the Feature Identification Results 
window to view the best hits for each feature in the list. Features shown in 
red are those whose Best candidate conflicts with the Best candidate for 
another feature. Note that two features are not considered conflicting if 
their Best candidates have the same formula but are associated with 
different database entries.

5 (optional) Click the Export button to export the Batch Summary results to 
a .csv file for use with Excel or other programs.

6 (optional) Click the Save As button to save the identification results in a 
feature composition file (.fcf format). 

Tip If results are saved as described in Step 6, you can open them later by 
selecting Open Search Result from the Identify menu in MassHunter Mass 
Profiler Software.

7 Click the Close button to close the Feature Identification Results window.

To view batch search results later

If you saved batch search results as described in “To identify a batch of 
features”, you can view the results later by selecting Open Search Result from 
the Identify menu in MassHunter Mass Profiler Software.
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Exporting Mass Profiler Data

This section describes how to export data from MassHunter Mass Profiler 
software for use with other programs, such as Excel and GeneSpring MS.

• “To mark features for annotation” below

• “To export data from the Feature Table” below

• “To export data from the Feature Plot” on page 38

• “To export feature summary data from a Batch Search” on page 39

To mark features for annotation

Use this procedure to mark any features of special interest. These marks will 
be included when you export data from the Feature Table or the Feature Plot.

1 Right-click the row number for the feature of interest in the Feature Table.
2 Select Mark On/Off from the shortcut menu. An X appears in the Mark 

column of the Feature Summary for the selected row (feature).
3 Repeat Steps 1 and 2 for all rows of interest in the table.
4 To clear a mark after it has been placed:

a Right-click the row number for the feature of interest in the Feature 
Table.

b Select Mark On/Off from the shortcut menu. The X is cleared from the 
Mark column for the selected row (feature).

To export data from the Feature Table

1 (Optional) Mark any features that are of special interest as described in “To 
mark features for annotation” above.

2 Select one of the following items from the File menu, depending on the 
format you want to use to export the data:

• Export Feature Summary from Feature Table to export summary data 
for use in Excel (.xls format)

• Export Inclusion List from Feature Table to export inclusion ion list for 
targeted MS/MS experiment (.csv format)

• Export GeneSpring Input File from Feature Table to export feature 
data for use in GeneSpring MS (.txt format)
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3 If you selected Export Inclusion List from Feature Table in Step 2, the 
Export Inclusion List Options dialog box appears. Set the following 
parameters for selecting representative ions for each feature.

a Mark Most abundant to use the most abundant ion for each feature.

b Enter an RT tolerance in minutes or accept the default value of 0.10 
minutes. This parameter is included in the file for use by data acquisition 
software. 

c Click OK.

4 Enter a location and name for the output file and click the Save button.

To export data from the Feature Plot

1 Display the features of interest in the Feature Plot as described in “To set 
Feature Plot filters and colors” on page 26 and “To select Feature Plot view” 
on page 27. Keep the following caveats in mind:

• When you export graphed features, only the features shown as solid dots 
are exported. Circles are filled or not based on the current Visibility 
criterion. If the Visibility criterion is set to None, then the result is 
equivalent to the table-based reports (for Mass vs. RT and Log2 Ratio vs. 
RT plots).

• The ratio and comparison plots can only include features that are 
present in both groups. You may get a different list of features depending 
on which graph you are exporting. The generated files include 
annotations to document what graph and visibility criterion were used 
to generate the export.

• The supported export formats are based on data averaged over one or 
more groups. Even if you choose a Plot style that displays individual per 
sample features, the export will still report the averaged feature data.

2 Select one of the following items from the File menu, depending on the 
format you want to use to export the data:

• Export Feature Summary from Graphed Data to export summary data 
for use in Excel (.xls format)

• Export Inclusion List from Graphed Data to export an inclusion ion list 
for targeted MS/MS experiment (.csv format)

NOTE For a description of other parameters on this dialog box, see the Export Inclusion List 
Options Dialog Box topic in online help.
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• Export GeneSpring Input File from Graphed Data to export feature 
data for use in GeneSpring MS (.txt format)

3 If you selected Export Inclusion List from Graphed Data in Step 2, the 
Export Inclusion List Options dialog box appears. Set the following 
parameters for selecting ions for the inclusion list.

a Mark Most abundant to use the most abundant ions.

b Enter an RT tolerance in minutes or accept the default value of 0.10 
minutes. This parameter is included in the file for use by data acquisition 
software.

c Click OK.

4 Enter a location and name for the output file and click the Save button.

To export feature summary data from a Batch Search

1 Perform a batch search as described in “To identify a batch of features” on 
page 35.

2 On the Feature Identification Results window:

a Review the hits for each feature on the Batch Result tab.

b If necessary, resolve conflicting hits, by either clicking in the Best 
column of a different row (hit) in the results table to manually select a 
different hit as the best fit, or by clearing the Best check mark to not 
select any best hit for that feature.

c Review the Composition Summary table on the Batch Summary tab.

d Click the Export button.
3 Enter a name and location for the export file on the Save As dialog box, 

then click the Save button. The file is saved in .csv format for use with Excel 
or other programs.

NOTE For a description of other parameters on this dialog box, see the Export Inclusion List 
Options Dialog Box topic in online help.
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